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Copyright
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cluding any copies installed on a hard disk.
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Trademark Information

Fontastic Plus, The Art Importer, and Family Builder are
trademarks and Fontographer is a registered trademark of
Altsys Corporation.

Multifinder, and Finder are trademarks of Apple Com-
puter, Inc. Apple, Mac, Macintosh, LaserWriter
ImageWriter, and AppleTalk are registered trademarks of
Apple Computer, Inc.
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registered trademarks of Adobe Systems, Inc.

FreeHand is a trademark and PageMaker is a registered
trademark of Aldus® Corporation.
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tered trademarks of CLARIS Corporation.
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Warranty Information

ALTSYS CORPORATION WARRANTS THAT THE
PHYSICAL DISK MEDIA USED IN THIS PACKAGE
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RECORDED. THIS WARRANTY IS FOR A PERIOD
OF 90 DAYS FROM DATE OF PURCHASE, DURING
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ALTSYS CORPORATION. ALTSYS CORPORATION
MAKES NO OTHER WARRANTIES, INCLUDING
WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE. ANY REM-
EDY UNDER THIS WARRANTY IS LIMITED TO
RETURN OF THE SOFTWARE AND USER'S GUIDE
TO THE DEALER OR TO ALTSYS CORPORATION
FOR REPLACEMENT OR REFUND. ALTSYS COR-
PORATION EXCLUDES ANY WARRANTY COVER-
AGE FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES. SOME STATES DO NOT ALLOW LIMI-
TATIONS ON IMPLIED WARRANTIES, SO SOME
OF THE ABOVE LIMITATIONS MAY NOT APPLY
TO YOU.

Program and User's Guide updates will be available from
time to time. Registered owners will be notified when an
update is available, and may purchase the update at a
substantial discount.
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Introducing...
The Art Importer

The Art Importer — The first product to allow you to
import artwork into the characters of a Macintosh font.
Now when you create a logo or draw a piece of artwork,
instead of going through the tedious procedure of copy-
ing and pasting into your Macintosh applications, you
can easily import that artwork directly into an Art Im-
porter font and then use it like any other font.

With The Art Importer, you have the ability to access
high-resolution PostScript art, as characters in a font,
without going through complicated importing proce-
dures. In addition, The Art Importer automatically cre-
ates screen fonts for your artwork in up to 127 sizes and
allows you to edit those screen fonts with editing tools
and a fatbits window. The font you create can be used
from any program with a font menu (such as MacWrite,
Microsoft Word or MacDraw). You can then print your
artwork at the full resolution of any PostScript printer.

This artwork can be EPS files from programs like Aldus
Freehand, Adobe Illustrator, Adobe Streamline, Breder-
bund's TypeStyler, or PICT drawing files from programs
like MacDraw or SuperPaint.

After you have installed your font, you will be able to use
that logo or picture with the touch of a single keystroke
from within almost every Macintosh application. You
can then resize that picture to any size that application
allows. For instance, FreeHand can resize your Art Im-
porter characters to 3,000 points high (about 40 inches)
and Quark XPress resizes to 500 points (about 7 inches).

Introducing The Art Importer 3



Betfore you begin...

What do | need to get started?

Before you actually start using The Art Im-
porter, check to make sure your package is com-
plete. Your package should include the following
diskettes:

The Art Importers "Program disk” and one or
more "Demo font” diskettes.

You must have a Macintosh Plus (or higher)
computer with at least 1 MB of RAM. If you
want to print high resolution copies of the char-
acters you create, you will also need a PostScript
compatible printer such as the Apple Laser-
Writer. The Art Importer can be run on a single
drive system (with some inconvenience), a two
drive system, or a system with a hard disk (rec-
ommended).

The System file on your disk should be version
4.2 or later, and the Finder must be version 6.0
or later.

Backup your Art Importer diskette

You should immediately make a copy of The Art
Importer's master disk for a backup copy. Before
you do anything else, turn your diskette over so
the backside faces you and push the black tab
up so you can see through the write-protect
opening. This will prevent you from accidentally
erasing any information while you make backup

COpIES.
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Find a blank diskette and copy The Art Im-
porter onto it by dragging the icon of the Art
Importer onto the blank diskette’s icon. Click
"OK” and change the diskettes when requested.
You should now use this new diskette and store
The Art Importer’s original "Program disk™ in a
safe place.

Read me...

All Altsys release and update disks contain a
TeachText document titled "ReadMe.” This
document contains information about the prod-
uct which may not be present in the User's
Guide. You should read this file before attempt-

ing to use the program.

Register for technical support

To become a registered user and receive techni-
cal support, you must complete and return the
registration card included in this package.

Altsys believes in customer support, and wants
to resolve any problems you have.

Our support lines are available on business days
Monday through Friday from 9:.00 AM to 5:00
PM Central Time. Qur support phone number is
(214) 424-4888. Please have your Art Importer
serial number on-hand when you call.

The remainder of this chapter tells you how to
begin using The Art Importer.

Introducing The Art Importer S



Installing The Art Importer

To install The Art Importer:

On The Art Importer diskette you'll see The Art
Importer's application icon:

wy

2.0

+ If you have a hard disk, create a new
folder on it by choosing "New Folder”
from the File menu.

+  Change the name of the "Empty Folder”
to "Art Importer Folder” or some other
name that makes sense to you.

»  Drag The Art Importer application from
The Art Importer diskette into the new
folder you just created.

That's all there is to it. You've just installed
The Art Importer.

6 " ART IMPORTER



Chapter Two

Background
Information
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THINGS YOU SHOULD KNOW

ABOUT ART

If you already understand what the acronyms
EPS, PICT, and TIFF mean, then you may skip
this section. Otherwise read on.

Supported formats

EPS (Encapsulated PostScript)

PICT

EPS (sometimes known as EPSF) is the Encap-
sulated PostScript file format originally devel-
oped by Altsys Corporation. EPS files may con-
tain a PICT (bitmap) representation along with
the PostScript description of a picture. Drawing
programs like Aldus FreeHand can produce this
format. To generate the EPS format from most
programs, you usually have to choose an option
other than the default "Save” settings. In most
instances, this is done via the menu item la-
belled "Export” or an option in a "Save” dialog

box.

The Art Importer gives you a way to import EPS
artwork files from Aldus FreeHand, Adobe Illus-
trator or Streamline, and Brederbund TypeStyler
into fonts which can then be used from any
Macintosh application that has a font menu.

The PICT file format is defined by Apple Com-
puter and is built into the Macintosh ROMs.

Many drawing programs like MacDraw or
SuperPaint can produce PICT (or PICT?2) files.

Background Information Q@



The Art Importer not only provides a way of
putting PICTs and PICT2s into programs that
normally handle only text, but because it actu-
ally translates the PICT into PostScript, you'll
gain all the smooth curves and high resolution
that PostScript is famous for. The Art Importer
cannot, however, use PICT files which contain
only bitmap images. If bitmaps are used within
your drawing, they will not appear in your Art
Importer characters. Although The Art Importer
recognizes and translates PICT files into Post-
Script, it will not recognize bitmaps. Most pro-
grams which can produce PICT or PICT2 files
do not automatically save in this format, but do
allow you to choose this option when you save.

Unsupported formats

TIFF (Tag Image File Format) and any bitmap file

10

TIFF (tag image file format) is a file format
originally developed by Aldus Corporation. A
TIFF image assigns grayscales to individual pix-
els. Hardware such as the Macintosh II, which
supports grayscales, displays pixels of a TIFF
image in varying shades of gray. Equipment that
does not support grayscales displays the pixels in
black and white. The Art Importer cannot read
TIFF files. Since TIFF is nominally a bitmapped
file format, and The Art Importer does not rec-
ognize bitmaps (SuperPaint, MacPaint), or EPS
files containing bitmaps only (these are normally
generated by scanners), it cannot use the con-
tents of a TIFF file even if it is converted to
PICT. To use a TIFF image, autotrace it in the
program of your choice, save it in EPS format
and then import it to The Art Importer.
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THINGS YOU SHOULD KNOW
ABOUT FONTS

If you already understand the Macintosh font
system, you may skip this section. Otherwise,
read on.

Bitmap fonts (screen fonts)

Bitmap fonts are the fonts you see on the Macin-
tosh screen (when you type) that can be used to
print on the ImageWriter and LaserWriter SC.
They are limited to a resolution of 72 dots per
inch on screen, but can be printed at almost any
resolution, given the proper printer. Bitmap fonts
normally reside inside the System file that con-
trols your Macintosh. You install them there us-
ing Apple’s Font/DA Mover program or Altsys’
Fontastic Plus. (Detailed information on install-
ing fonts begins on page 71). A bitmap font file
icon will normally look like this:

—

Al

Artwork bmap

The largest possible bitmap character (as de-
fined by Apple) is 127 points high (about 1 3/4
inches) by 254 points wide (about 3 1/2 inches).
The Art Importer, by default, automatically cre-
ates 24 and 48-point bitmap fonts.

Background Information /1



PostScript fonts (printer fonts)

12

PostScript fonts (downloadable fonts) are what
print from your laser printer. PostScript is a pro-
gramming language developed by Adobe Sys-
tems, Inc. to drive high resolution printers.
Bitmaps are always tied to a particular resolu-
tion, while a PostScript program can accomo-
date any resolution. This is done by describing
the shape of the graphic using Bézier curve out-
lines, which can then be scaled to almost any
size. Bézier curves are a type of cubic spline
curve which are mathematically defined in a
manner that makes it easy to join to other curves
and straight lines smoothly.

The Art Importer's PostScript font file has an
icon which looks like a Laser Writer with a sheet
of paper containing the letter "A" emerging from

&

Artwor

This PostScript file must be put in your System
Folder so that when the LaserWriter driver no-
tices it is printing a PostScript font, it can down-
load this PostScript font file into the printer
automatically (Detailed information on install-
ing fonts begins on page 71).
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Chapter Three

The Art Importer’s
Basic Steps
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THE ART IMPORTER'S
BASIC STEPS

The Art Importer's basics are so basic that we've
fit the entire process on these two pages. This
overview demonstrates how easy it is to create
and use your own font. It's so easy, in fact, that

you could create and be using a font in ten
minutes or less'

Seven Easy Steps to an Art Importer font

1. Start the Art Importer

+  Double-click on The Art Importer’s icon
or click on its icon and choose "Open”
from the File menu.

2. Create a new font

+  Choose "New font. .."” from the File menu
or type 6N,

+ Click "OK"” in the Font Attributes dialog
box.

3. Import a file

+  Click on a character slot to select it or type
the desired character.

+  Choose "Import” from the File menu or type
L

+  Select the desired piece of artwork.

Ihe Art Importer s Basic Steps 15
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Save your font

Use the "Save” command from the File menu
or type #£S.

Make sure you follow the naming rules on
page 58.

Print a sample

-

Choose "Print sample. . . ” from the File menu
or type 48P.

Select a "Print sample” type.

Install your font

L ]

Install your PostScript font file
Install your bitmap font file,

Refer to page 71 for font installation proce-
dures.

Use your font

*

Choose your Art Importer font from your
application’s font menu.

Type your characters in the point size(s) of
your choice.

Yes, it's that easy! Now that you have learned
the basic steps involved in creating an Art
Importer font, you can proceed to the next
chapter for more detailed information on
creating your own fonts.
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Chapter Four

Using The Art Importer
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OPENING A FONT

Now you are ready to begin creating your own
font. There are two ways to start The Art Im-
porter:

To start The Art Importer:

+  Click on its icon and choose "Open” (360)
from the File menu.

=il

OR (the preferred method)
+  Double-click on the Art Importer icon.
The Art Importer will display an opening

screen that contains copyright and version
information.

"CART IMPORTER|

‘_\ Create PostScript fonts
C

from Mocintosh artwork

[ ;,)
Beriary Vo i Spele,
ared Parry Lagiaa

W ian daw
Mgy A vndaabibe
agchuea Mok |
St wwruion 0

When you see the menu bar appear, you
have the option of creating a new font or
opening an existing font.

Using the Art Importer 19
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To open an existing font:

There are three ways to open an existing font.

-

OR

OR

Double-click on the font file’s icon from
the desktop. This starts The Art Importer
and opens that file for editing.

While the Art Importer is running double-
click on an Art Importer document (this
works only if you have no other Art Im-
porter documents open).

While The Art Importer is running choose
“Open font. . .” from the File menu or type
0 (this works only if you have no other
Art Importer documents open).

This presents the standard file selection dia-
log, which allows you to choose a font file.
The file selection dialog works in the stan-
dard fashion, so you can change drives,
eject disks, open a file, or cancel.

€3 Artimporter Fonts

= Hard Disk

| Ejoct |

EII’II!HI \
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+  Choose the font you wish to open by click-
ing on its name and then clicking "Open”
or double-click on its name.

To create a new font:

+  Choose "New font. .."” from the File menu
or type EN.

Setting font attributes

When you open a new font, The Art Importer
presents you with the "Font attributes” dialog
; box.

Font attributes

Font name: Untitled
Sizes: E‘H, 48

Fond 1D 1427

This dialog box lets you choose the bitmap font
sizes you want to create. The Art Importer auto-
matically defaults to the creation of 24 and 48-
point bitmap sizes (about 1/3 of an inch high
and 2/3 of an inch high). Point sizes on the
Macintosh usually follow the fairly standard pro-
gression of 24, 36, 48, 72, and 96, but you may
specify other values. If you remove numbers
from the "Sizes” box, the corresponding sizes will
be removed from the bitmap file. If you want
larger or smaller bitmaps created for you, this is
the place to add those sizes.

Using The Art Importer 21
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To add bitmap sizes:

+  Type the sizes you need in the "Sizes” box,
making sure you include commas between
all the sizes.

The Macintosh limits bitmap font sizes to be-
tween | and 127 points.

Each point is 1/72 of an inch so a 72-point
character should be approximately one inch tall.
You cannot create bitmaps larger than 127
points tall on the Macintosh, although many
programs can show and print any size character
(for instance, Aldus FreeHand can show charac-
ters up to 3000 points). Since the Macintosh can
scale bitmaps, it is unnecessary to have bitmaps
in all sizes if you don't mind what you see on the
screen. You can print at all sizes even if you have
only one size of bitmap font. The Macintosh will
scale the one size you do have, showing you an
approximation on your screen. Your PostScript
printout will be unaffected and will retain its
high resolution regardless of its printed size.

™ ART IMPORTER



FOND IDs

The FOND ID field is provided to assign the
font family ID. Bitmap fonts are identified inter-
nally by a unique number ranging between 1
and 16383. Numbers between 1 and 1023 have
already been reserved by Apple and other font
developers and should not be used. Apple has
reserved font numbers between 3071 and 16383
for commercial use. By default, The Art Im-
porter will automatically choose an appropriate
[D number for you. We suggest you use the
automatically assigned 1Ds instead of assigning
your own number unless you are very familiar
with the ID numbers of the fonts already in-
stalled in your system. If you assign your own
font numbers, Altsys strongly recommends that
you use the range from 1024 to 3071 or contact
Apple Developer Technical Support for an as-
signed 1D.

The Art Importer generates NFNTs (New fonts)
instead of FONTs because NFNTs allow a
wider numbering range, many more fonts at
once, and less chance of ID conflicts. The
NFNT is the font resource which contains the
image of your screen font. There is one NFNT
for each point size. NFNTs originated with the
advent of the 128K ROM Macintoshes. Earlier
Macintoshes used the FONT resource type,
which had a range of ID numbers no higher
than 255. Some older programs do not recognize
NFNTs, so if your fonts don't show up in your
program's font menu, contact the software com-
pany and ask about updates.

Using The Art Importer 23
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To change the Fond ID:

*

Click in the "Fond ID” box and type over
the number with your new number.

Note: Remember to use numbers in the
range of 1024 to 3071 since this range is set
aside by Apple Computer, Inc. for unregis-
tered fonts.

Click "OK.”

The Art Importer will present you with an
empty font window labeled "Untitled”.

You can change any of the entries in this
dialog at any time but it's usually a good
idea to set them up at the beginning before
you start creating your font.

" ART IMPORTER



The font window

The font window has a title bar (which displays
the name of the font being edited), zoom button,
close box, size box, and scroll bar just like the
standard Macintosh window.

Like any other window, the font window can be

moved (by dragging the title bar) or closed (by
clicking on its close box).

Character slot

Just below the title bar are the character slots.
All characters can be accessed by clicking on
them with the pointer tool, or simply typing the
character. Typing a key on the keyboard when
the font window is active causes the corre-
sponding character box to become highlighted.
The display scrolls automatically to show the
typed character if it is not in the visible area.

Each font is composed of 256 character slots,

each of which corresponds to a character that
can be typed from the keyboard. A slot can con-
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tain your logo, picture of the Golden Gate
Bridge, The Eiffel Tower, or any graphic image
you desire. The contents of a slot are highlighted
whenever the corresponding key is typed while
the font is open.

1 Font label

Character slot

The scroll bar can be used to select the particu-
lar range of slots which are visible. Each slot
consists of an upper and a lower box. The lower
portion of the slot shows a bitmap depiction of
the character contained in that slot. This image
defaults to a 48-point character if one is avail-
able, or the currently active size in the character
edit window, or the next available size. The
font label (the upper portion) displays a code
which represents the character. The font label is
highlighted if the slot has been edited since the
font was opened or last saved. In addition the

upper portion has a bold border if the character
has been defined (contains an image).

= [ ]

Highlighted - Bold border -

slot has been edited  slot contains an image
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Preceeding the character slots that contain al-
phabetic font labels are slots that contain the
control characters.

C-a

These slots correspond to your keyboard's con-
trol keys and always begin with "C-". These
characters cannot be accessed from non-ADB
(Apple Desktop Bus) keyboards. ADB keyboards
can access these characters by holding down the
Control key and typing the letter that follows
the "C-". The first 33 character keys (those be-
fore the exclamation point character) can only
be accessed by clicking on their slot with the
pointer.

At the bottom of the font window you will find
character slots that are labelled with an "*"
These also cannot be accessed from the key-

board.
* * j' *
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However, there is one slot that actually contains
the asterisk character. This key can be accessed
by pressing the Shift key and typing the number
Y.

Directly after the character slots which contain
the alphabetic images are character slots that
contain the "Option” and "Shift-Option” keys.
They correspond to your keyboard's Shift and

Option keys and always begin with the letter
O or "S0":

In this example, the keyboard command would
be "Shift-Option-a”.

S0aq

This example indicates that you enter "Option
e" and then type "E".

DeE
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PUTTING ART INTO YOUR FONT

There are two ways to insert your artwork into a
character: import directly into the character or
cut from another application and paste into a
character slot.

To import your artwork into a font:

+  Select the letter into which you want to
insert your artwork by clicking on its char-
acter slot.,

OR
+  Type the letter on your keyboard.

If you had selected the number "1.” the font
window would look like this:

ENEIE—————— '
4 s & T B

E |

Once you have selected a character you are

ready to import a file that has been saved in
PICT or EPS format.
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+  Choose "Import” (3€]) from the File menu.

A standard File selection dialog appears.

O AppleRrtGray
0O Arch with Stairs.eps
O Carlton Dino Demo.eps _.: (

.
—_—
—
]
=4
-
Y

o=
=
=
®

0O Daffy.eps

O Elephant art.eps
0O Floor Plan #1.PICT i
D Floor Plan #2.PICT 5y |_Cencel

[ ChessHorse.eps . yl

i

[ open

i

+  Double-click on the name of the piece of
art you want to import into the selected
letter, or select the name and click “Open.”

A dialog box appears which shows the im-
porting progress.

File : Bridge.eps

Importing...

Contructing paths
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When the import is finished, a bitmap ver-
sion of your character will appear in the se-
lected letter's display box.

ERE—— ="
titled EEEEESEES
o 2 a E]

It your character box is solid black, you've
imported an EPS document that was cre-
ated without an associated PICT. Some
programs do not save a PICT with the file
when they generate an EPS file.

Having a PICT to go with your EPS docu-
ment isn't important unless you want to see
a bitmap depiction of your image in which
case you can manually create your own
bitmap image. There may be instances
where you do not want to see an exact
bitmap representation. For example, you
may have a document or drawing that you
want to identify by a single word or line of
text. You can manually place bitmaps to cre-
ate your own unique label. For example:
you might label the MasterCard™ icon
"MC" or your detailed drawing of your
mother "Mom.” Hand editing is covered in

detail in the next section, "The Character
Edit Window "
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[f you want to see a more accurate represen-
tation of your artwork, recreate the EPS file,
making sure to generate a PICT with it,
reimport it to your Art Importer font, and
you'll see the picture you're looking for. You
may need to edit the bitmap image for clar-
ity, especially the smaller sized bitmaps
(those under 24 points). If you double-click
on the newly created bitmap of your art-
work, you'll see a character edit window
similar to the one shown on page 37.

To copy and paste:

If you are copying a PICT image from another
application:

-

Select and "Copy” (36C) the image while in
your application.

Select an Art Importer character by click-
ing on it.

Choose "Paste” (3€V) from the Edit menu.

If you are copying a character from another
Art Importer font, you must close the font
window of the originating font before you
can paste into the new font’s character slot.
Two font windows cannot be open at the
same time.

Note: Remember that you must paste PICT
or PICT2 drawings, not bitmaps or TIFF.
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EDITING A CHARACTER

The Character Edit Window

If you double-click on a letter into which you've
already imported a picture, you'll see a character
edit window similar to this which shows the
bitmap representation of your imported image.

e from ArtFont-48

of fsat 2 width 39 El

This picture shows the 8X magnification. If you

look at the Special menu, youll see that there
are also 4X and 2X magnifications.

Previous point size 1
Nart paint size LW

v8H magnification H#E
44 magnification ¥R
2u magnification T |
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The character edit window can be sized so that
you can see the entire image by dragging on the

size box.

ffesaet 2 width 39

The Art Importer has a preview box for viewing
your drawing, and five editing tools. These are
the scroll hand, the pencil, the eraser, the width
tool, and the move tool. All of the tools are used
to manipulate the bitmap image of your charac-
ter or picture. Some of the tools (discussed on
the next few pages) also affect the PostScript
character. The Art Importer’s tools are located
on the left side of the character edit window in
the tool palette and are nearly identical to their
counterparts in MacPaint.

Q Preview box

Scroll hand

4 — Pencil

W,
Q — Eraser

———— Widlth tool

————— Move tool
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The tool palette

The scroll hand

L£Y ]

The pencil

J

The scroll hand gives you control over
the position of the picture within the
edit window.

As a shortcut you can hold down the
Space bar to get the scroll hand. You
can then drag the image around to a
comfortable position before you begin
to edit the bitmap. You can switch from
any tool to the scroll hand by pressing
down the Space bar.

The pencil is the tool for turning the
dots in your bitmap on and off. You can
either drag or click with the pencil
Clicking draws just one dot. Dragging
produces a line of dots.

Holding down the Shift key while drag-

ging constrains drawing to a vertical or
horizontal straight line.

Note: Any changes made with the pen-
cil tool affect only the point size being

edited.
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The eraser

| £ |

The eraser removes or erases any dots
under it. If you'd like a better view of
the entire bitmap character as you
erase, use 4X magnification” or "2X
magnification” from the Special menu.

Note: Any changes made with the
eraser affect only the point size being

edited.

The width tool

40

(]

The width tool lets you change the
amount of horizontal space that your
character will take up.

Note: Any changes made with the
width tool affect the PostScript charac-
ter and all bitmap sizes for that charac-
ter. We suggest using it only on the larg-
est size bitmap for greatest accuracy.

To change the width:

+ Place the pointer or crosshair (at
the position where you would like
the width guideline) and click.
The width guideline will automati-
cally move.
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An Art Importer character can be a
maximum of 254 points wide. If the
character width is set to a setting of
more than 254, a bullet will appear in

the lower right-hand corner of the font
label.

When you save your font, a dialog box
appears notifying you that some
character(s) are greater than 254 and
have been set to 255.

The move tool

The move tool lets you change the po-
‘ ‘%’ sition of the artwork within its bound-
ing box. The move tool lets you move
the picture up or down, right or left.
You should always move the largest size
bitmap to minimize any discrepancies
between the bitmap's position and the
position of the PostScript that will be
printed out.

Note: Any changes made with the
move tool affect the PostScript charac-

ter and all bitmap sizes for that charac-
ter.
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Holding down the Shift key while using the
move tool constrains your movements to
horizontal or vertical lines.

Holding down the 3 key while using the
move tool decouples the PostScript position
from the bitmap position. This is something
you normally don't want to do, but might
need in some very special cases; for in-
stance, to adjust one size of bitmap that you
would like to remain independent of the
other sizes.

Note: An image can also be moved by
choosing "Character info..." from the Spe-
cial menu. See "Moving an image” on page
50 for detailed information on moving an
image with the Special menu.
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Character edit window guidelines

B A from ArtWork-24

2 |
&1 a2
E " ™\ Ascent
4 Total - (Position: 800)
£ 3 height- \
\ ™\ Width
*--Bc:iseline
} [Pmsiric}n: 9)
offset 0 TL width 15
Orlgm Descenf
(Position: O)  (Position: -200)
Em-square

Each character fits within a rectangle (bounding
box) called an em-square. The em-square is the
outer square around the letter or character. The
square is so named because it is nominally as
wide and the same height as the letter "M.”
There are 1,000 units in an Art Importer em-
square. This em-square is used as a normaliza-
tion value when generating PostScript and also
defines the precision possible in the font.

The total font height, or em-square, is deter-
mined by the distance between the ascent and
the descent. All fonts are normalized inside the
LaserWriter or any other PostScript printer so
that their em-square is one point (approximately

1/72 inch) high.
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Width

Ascent

The width line is a moveable vertical line
which specifies the width of each character.
When drawing characters on a page, the origin
line of the next character is placed on top of the
width line of the current character. If your char-
acter has points that extend to the right of the
width line, they will probably overlap the image
of the following character.

The ascent line marks the top of the capital
letters and is the cutoff point above which your
bitmap character cannot go. The ascent line is
at a position of 800. You cannot change the posi-
tion of the ascent line.

Descent

44

The descent line marks the lowest point of the
descenders of such letters such as "y" or p" and
is the cut-off point below which your bitmap
character cannot go. The descent line is located
at a position of -200. You cannot change the
position of the descent line.

Note: If you move your bitmap image above the
ascent line or below the descent line, your
bitmap depiction will be cut off at that point. If
you move that same image back, the image will
not reappear. However, your PostScript charac-
ter will not be affected and will print perfectly.
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If your bitmaps have been clipped because you
moved your image above or below the ascent or
descent, you can get the original bitmap back.

+  Change the scale factor to something other
than its current setting ( i.e., if it is "1”,
change it to "1.1") and scale.

« Reset the scale factor to the size you wish
the character to be and rescale.

The Art Importer will redraw the bitmaps
when it rescales the character. Scaling is
covered in detail in "Scaling an image” on
page 48.

Baseline

Origin

The baseline is the line on which characters
normally stand. When printing mixed fonts on a
line, all baselines line up with one another. The
baseline position is always at a vertical location
of zero. If you would like your character to have
a descender, like a lower case "y" or “p,” you
would move it below the baseline.

The origin line goes through the origin point on
the baseline. The origin of the em-square is al-
ways at the location of zero. This is where the
"drawing pen” of the Macintosh will start draw-
ing your character. If your character extends to
the left of this line it will have a negative offset
and will overprint the preceding character. If it
starts somewhere to the right of this line it will
have a positive offset which will create space
between the previous character and this one.
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Editing via the Special menu

46

Previous point size 31
Next point size 82

v81 magnification #E
44 magnification ER
2% magnification 8T

Previous character 38|
Next character 3]
Character info...

The Special menu gives you the ability to:

Enlarge or shrink the bitmapped picture in
your editing window;

Choose the previous or next point size;
Choose the previous or next character;

Scale a character to a specific em-unit size;
and

Move a character to a specific point.
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Magnifying your bitmap image

The Art Importer's various levels of magnifica-
tion come in handy when editing bitmaps. At
2X magnification you can usually fit an entire
character on the screen.

To change the bitmap magnification:

+ Choose the magnification you wish to
show in the window by selecting it from
the Special menu.

When you're editing large bitmaps, toggling
between the various magnifications with
HT (2X), #R (4X), and HE (8X) can speed

this process immensely.

Next and Previous point sizes

The Art Importer allows you to compare your
edited character at the various point sizes you've
created.

To choose the previous point size:

+  Choose "Previous point size” (3€1) from the
Special menu.

To choose the next point size:

+  Choose "Next point size” (3£2) from the
Special menu.
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Next and Previous characters

To choose the previous character:

+  Choose "Previous character” (3€] ) from the

Special menu.

To choose the next character:

+ Choose "Next character” (3] ) from the
Special menu.

Scaling an image

The "Scale factor” can be set to increase or de-
crease the size of the PostScript and bitmap im-
age by a specified scale factor.

To scale an image:

+  Choose "Character Info. .."” 3€W) from the
Special menu to scale a character larger or
smaller relative to the other characters in
the font.
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A "Character information” dialog appears which
allows you to type in your scale factor. The
scaling range can range from .1 (102 of the nor-
mal size) to 10 (10 times the normal size).

Character information

H translate 0 em units
¥ translate 0 2m units

Scale factor |1

+  (lick in the "Scale factor” box or use the
Tab key to move between boxes.

«  Type in your "Scale factor.”

Scaling a character can be very useful. You
may want to have a character be a size
other than the standard representation of a
point size within your font. For instance, you
could have varying sizes of your credit card
icons within one font. Or you might want
your icon to fill the full point size by filling
the entire area between the ascent and the
descent.

Note: Scaling automatically regenerates the
PostScript character and all bitmap sizes for
that character. Make sure you perform any
scaling operations before you hand edit your
bitmaps.
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Moving an image

The "Character information” dialog allows you
to reposition your character without using the
"Move” tool. The units used in the "X translate”
and "Y translate” items are em-square units.

An Art Importer character’s height is made up
of 1,000 em-units. The origin point is at the bot-
tom left of your character at the position 0,0.
The "X" units move horizontally while the "Y”

units move vertically.

To move an image:

+  Choose "Character info. ..” from the Spe-

cial menu.

+  Enter the "X"” and/or "Y" coordinates.

H translate

¥ translate
Scale factor

1joo

Character information

em units
em units

20
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Since we typed in 100 in our example, our
image will move 100 em-units to the right of
the origin.

Positive "X" values cause the character to
translate to the right of the origin.

Negative "X values cause the character to
translate to the left of the origin.

The Character Edit Window S



For the example below, we entered a nega-
tive value which moves our image 150 em-
units toward the descent.

Character information

H transiate em units
¥ translate em units
Scale Tactor

Positive Y™ values cause the character to
translate up from the baseline.

Negative "Y" values cause the character to
translate down from the baseline.
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Undo and Redo

Undo

The Art Importer supports "Undo” and "Redo”
of the last four edit operations from the edit
window.

[f you make a mistake in editing, scaling, or
moving, simply choose "Undo” (387) from the
Edit menu to undo your changes. Changes can
be "Undone” up to four levels back.

Undo pencil, 3

Redo pencil

[f there is nothing to undo or redo. the corre-
sponding word is grayed out, otherwise the op-
eration is listed along with the command.

Note: This "Undo” applies only to the current
character in the current size.

The Character Edit Window Ao |



Redo

You must “‘Undo” an operation before you can
"Redo” the operation. Select "Undo pencil” and
undo the last operation, or "Redo” to redo the
operation that was just undone.

Undo pencil 32
Redo pencil,. #

------------------------------------------------------------

Performing the "Undo pencil” restores the char-
acter to the way it was before any editing was
done.

Editing may be resumed at any point, but obvi-
ously once a change is made, you cannot redo
back to intermediate versions.

Deleting a character

To delete a character:

+  Select the character you wish to delete by
clicking on its character slot in the font
window or simply by typing the key.

+  Choose “Clear” from the Edit menu.
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SAVING A FONT

You can save fonts via the "Save” or "Save as...
commands in the File menu. When you choose
a "Save” option, the standard Macintosh file sav-
ing dialog will display. This allows you to specify
the file name, change drives or folders, eject
disks, or cancel the operation.

€3 ARTImporter |
L 10°% Shuitle.eps = HardDisk
0 At Drawings i
& Mt tmporter 8-16 (] (_Eiect
0 Mt tmporter Guilines Drive )
0 Mtimparter Tampl... |
0y charnctier window, ...
Save font as: [ Save | I

[prront | T

"Save” and "Save as...” commands work from
the font window.

The "Save” command saves any changes back to
the file you originally opened. If you create a
new font, "Save” works just like "Save as...”

The "Save as...” command gives you the oppor-
tunity of saving the active font window under a
new font name. It is important to choose a name
which conforms to the naming conventions de-
scribed on the next page.

Saving and naming fonts k7



Naming a font

58

PostScript rules for naming a font:

*

The font name must start with a capital
letter, but the name should not be entirely
capitalized.

No spaces or special characters should be
used inside a name.

Periods are acceptable, but they are
stripped off (along with anything after the
period) when The Art Importer generates
bitmap and PostScript files.

The complete font name must be at least
six characters long.

When abbreviating a name, each capital-
ized name component is treated as a sepa-
rate component. The first five characters
of the first part, then the first three charac-
ters of each following part are brought to-
gether to construct the abbreviated Post-
Script font file name. Such abbreviated
names must be different from The Art Im-
porter font file name. Thus, "ThislsBad” is
unacceptable because the constructed Post-
Script font file name is also “ThislsBad”.
The name "ThislsGood” is fine, because
the constructed name is “ThislsGoo” (each
component after the first uses at most three
letters of that component).
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+ If you must have a short name like "A”", put
a suffix on it: "A.artwork”. The abbreviated
PostScript font file name is then "A”, the
bitmap file name is "A.bmap”, and the
bitmap font name in the font menus is "A".

+ The total length of the abbreviated file
name must be less than 32 characters. This
may limit the number of components used
in a name.

+ Use simple names so you'll be able to
clearly associate the various files that The
Art Importer creates for you.

+ The Art Importer check sthe name you
give a font and issues an error message if
your name doesn't conform to the rules
given above.

The next page lists examples of good and
bad font names.

After you ve named your font

Once you've named your font, you can click the
"Save” button and vour font will be saved to
your disk.

Renaming a font

Never attempt to rename a font by changing the
names of any of The Art Importer files while in
the Finder. The only way to rename an Art
Importer font is to use the File menu's "Save
as...  option.
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Examples of good and bad font file names:

The Art Importer  PostScript  Bitmap

A A A bmap
Bad: Art Importer name is too short and conflicts with PostScript
abbreviation

A.artwork A A.bmap
Good: No conflicts

ACAPFONT ACAPFONT ACAPFONT.bmap

Bad: Name is all caps and conflicts with PostScript abbreviation

AGoodName AGooNam AGoodName.bmap
(Good: No conflicts

ABadOne ABadOne ABadOne.bmap

Bad: Name conflicts with Post Script abbreviation

Very Bad (error) Very.bmap
Baa: Has blank which causes PostScript errors

Mine 1 2.artwork Mine12 Mine 1 2.bmap

Poor: Numbers are allowed, but can be confused with point size

Not$Good (error) Not$Good.bmap

Bad: Has special characters
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PRINTING A SAMPLE

Now that you have imported your image and
prepared your font, you'd like to see your
character(s) in various point sizes. And you'd
like to see it before you actually go through the

font

installation procedures to make sure it

looks right.

To print a font sample:

From either the font or character edit window-

+  Choose "Print sample...” ($P) from the
File menu.

The "Select print sample type” dialog will
appear.

Select print sample type

@ Print key map
@® 1 page O 4 pages O 16 pages

Point size

The quick brown fox jumps over the
lazy dog.

() Print string

Orientation: ® Portrait

O Landscape

| Cancel |

You have the option of printing "Portrait”
(tall) or "Landscape” (wide) if you choose the
"Print string” option.

Printing fonts
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Print sample type options

The Art Importer provides several options for
printing font samples.

Choose either "Print key map” or "Print
string” (in which case you must type the
character(s) to print) and click "OK.”

A standard "LaserWriter” dialog appears
which offers you the option of choosing spe-
cific page numbers for printing.

Laseriiriter “Speedy” oK |
Enpur.i| Pages: & AN {:hrr-m:i iTn:{ |

Cover Page: @& No O First Page O Last Page
Paper Source: @ Paper Cassette O Manual Feed
Print: ® Color/Grayscale O Mack & White

Note: If you know your character's key
number you can specify the page sequence
to print that character without printing all
your other characters.

Click "OK.”

Print key map

Choosing “Print key map” will print out a grid
that looks similar to what you see in the font
window. You'll get a printed sample of all the
characters along with a guide to the relationship
between keystrokes and artwork. The Art Im-
porter gives you the choice of printing a variety
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of page samples. These can be useful for keeping
a record of the font's characters for later refer-
ence.

Key Caps, which is under the Apple menu, is
used to see which character is assigned to a
specific key. But sometimes it is hard to distin-
guish an intricate character at such a small point
size. In these instances, it is beneficial to have
The Art Importer's printout to refer to.

Choosing the "1 page” option prints all 256 char-
acters in the font on one page. The printed
sample will have 16 rows across and down the

page.

A

&0 | 1 page option

Choosing the "4 pages” option prints 64 charac-
ters on each of the four printed pages. The
printed sample will have 8 rows across and
down each page.

l A

@ 4 pages option
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Choosing the "16 pages” option prints 16 charac-
ters on each of the 16 printed pages. The
printed sample will have 4 rows across and
down each page.

16 pages option

Print string

Choosing the “Print string” option allows you to
choose which characters you wish to print and
allows you to change the point size at which
they print. When you edit the string in the box,
be sure to use the proper case for the letters you

type.
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Page Setup

Once you choose your print options, you can
follow the standard Macintosh printing proce-
dure.

+ Select the printer of your choice from
"Chooser” under the Apple menu.

+  Choose "Page setup. . .” from the File menu.
+  (Click "OK.”

A standard LaserWriter Page Setup dialog
box appears.

Laseriliriter Page Setup D o0
Paper: @ US Letter O A4 Letter m
O S Legal O BS Letter O [_Tabloid I

(Cancer )
Reduce or |.]1 Printer Effects:

Enlarge: (] Font Substitution?
Orientation (2] Tent Smoothing? [E

":1 [=] Graphics Smoothing?
e [ Faster Bitmap Printing?

The Art Importer ignores the "Reduce or En-
large” scale factor and "Orientation” in this dia-
log box since these aspects of printing are con-
trolled from the individual type of print sample.
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Closing your font file

To close the font file:

+  Choose "Close” (3K) from the File menu.

If you haven't saved your font yet, The Art
Importer will ask you if you want to save
the changes you've made. Normally you'l
answer "Yes' to save your changes.

Quitting The Art Importer

To quit The Art Importer:

+  Choose "Quit” (36Q) from the File menu.

If any changes have been made to the font,
you will be prompted to save your changes
before The Art Importer quits.
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INSTALLING YOUR FONT

If you already know how to install PostScript

fonts, you may skip this section. Otherwise read
on.

Installing PostScript fonts

The PostScript font file has an icon which looks
like a LaserWriter with a sheet of paper contain-
ing the letter "A" emerging from it. It is easy to
install.

To install the PostScript font file:

+  Use the Finder to drag the PostScript font
file into the System Folder on the disk
with which you will be using the font.

Finder EE_

Systern Folder

Installation is complete.

Note: In case you are thinking about put-
ting the font file somewhere other than the
System Folder, read this:

The printing software looks in the System
Folder first when searching for a PostScript
font. If it doesn't find it there, it may look in
the folder containing the application doing
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the printing (where it looks varies with the
system release). We suggest you put the Post-
Script font into the System Folder, rather
than the application folder, thus eliminating
a major source of confusion. Scattering a
few fonts in each application folder quickly
grows to the point where there are several
versions in different folders and each prints
slightly differently. Things get out of control
and it is impossible to remember which font
to use for a particular print job. Sometime
later, you change a character, but the
change doesn't seem to "take” since your
print job picked up an old version of the
font. It has happened to us; it can happen to
you—make life easy and put PostScript
fonts into your System Folder.
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Installing bitmap fonts

If you already know how to install bitmap fonts,
you may skip this section. Otherwise read on.

To install a bitmap font file:

»  Double-click on the bitmap font file.

Al

Artwork.bmap

The Art Importer's screen fonts are repre-
sented by an icon of a suitcase with the
letter "A" inside it. The Font/DA Mover
will start up, showing the contents of your
file in the left window.

+  Click "Open” in the right window, then
find and "Open” your System file with the
file selection dialog.

+  "Copy” your font into your System file.

Note: It is a good idea to remove your old
fonts before adding new (updated) fonts.

Make sure you have Font/DA Mover ver-
sion 38 or above. If you are not familiar
with its use, refer to your Macintosh Utili-
ties manual.
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When you have installed both files, your
font’s name should appear in the font menu
of any application you run. If your font
doesn't show up, try reinstalling the bitmap
font with the Font/DA Mover, and make
sure you are installing it into the System file
that is running your computer. There should
be only one System file on your startup disk.
Use the “Find File" desk accessory to find all
the files with the letters "system” in them

and get rid of any redundant System files or
System Folders.

You may also install the bitmaps with Suit-
case, Master Juggler or Font/DA Juggler.
Install your fonts according to their instruc-
tions. The Art Importer fonts are compat-
ible with all of these programs.

Note: You must never change the names of
any of your Art Importer files by renaming
from the Finder. There are complex internal
structures in both files that contain the file
names and it is not practical to try to
change them yourself. If you need to change
a font's name, use the "Save as...” option
from the File menu.
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Chapter Ten

Using fonts






USING ART IMPORTER FONTS

Once you have installed your font according to
the directions on page 71, using your font is as
easy as selecting from the font menu in any ap-
plication you may be running. The exceptions to
this are versions of Microsoft Word earlier than
version 4.0. In these instances, you must follow
the instructions in the Microsoft Word manual
regarding the installation of new fonts into
Word's font menu.

Once you have chosen your font's name from
the font menu, simply type the character associ-
ated with the artwork you wish to show and you
will see a bitmap representation of the artwork
appear on your screen. For example, if you type
the numbers 1, 2, and 3 in the ArtWork font
you've seen elsewhere in this manual, you'll see
on your screen:

Q@ 24

Our zebra image was originally an Adobe
Streamline EPS file without a PICT. We hand
edited the bitmap image to create a label that
will easily distinguish the image that appears in
our character slot. What will print is:
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Now you can go out and create some interesting
new art fonts. Be creative and put your com-
pany's logos into a font so you can use them in
documents and save the cost of printing letter-
heads. Write letters to friends using icons in-
stead of words. Get a picture of your boss and
shrink his head down to 12 points. Make pic-
tures of postage stamps and print them on your
envelopes to save postage (Just joking, Uncle
Sam!). The sky's the limit! Go for it.

Color Art and The Art Importer

/8

The Art Importer allows you to import your
color artwork and then use it in subsequent text
and graphics. In order to take full advantage of
your original art and the capabilities inherent in
The Art Importer, there are a few criteria to
keep in mind.

Although The Art Importer imports color illus-
trations, your screen font will not show those
colors. However, when you print your font to a
color printer, all the original color(s) will be ap-
plied.

Some programs (such as Aldus FreeHand and
PageMaker) allow you to apply a specific color
to a character. If the Art Importer character
contains color, even though you apply a color to
the character, your printed font will print con-
taining the original colors.
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In other words, the original Art Importer color
attributes will override any new characteristics

you apply.

Therefore, if you have a character to which you
would like to assign a color, you should create a
separate copy of the color illustration, with the
color removed (making it black), and import or
paste it into another character slot. The Art Im-
porter allows you to create black characters and
color characters within the same font.

Guidelines for using color:

+  The Art Importer treats characters contain-
ing multiple grays the same way it treats
color illustrations.

[f the character contains internal color or
grayscale changes, it cannot be colorized
when used. It should nonetheless be col-
orized as 100% cyan, magenta, yellow, and
black just so it gets separated properly. This
is because some separating programs only
send text to the plates they think it belongs
on, and can't see the internal colors.

If you have a color or shaded (filled) illustra-
tion that you might want to print in black
and white only at some time, make a sepa-
rate copy of the original illustration without
color. You might save each copy with spe-
cific names for easy recognition. For ex-
ample: Bird-color.eps, Bird-gray.eps. or Bird-
b& w.eps.
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+  If the character is only black, it can be col-
orized from any program and takes its color
from that program. When using an Art Im-
porter font in an application, you may apply
color to solid black characters (those con-
taining no gray or white fills),

Characters that can't be colorized:

— Anything that isn't a black fill
— Zoom text
— Fill and stroked characters

— Any graduated or radial fills
— Characters containing white

Using color separations

80

If you have a color illustration that you will be
taking to a printer for reproduction, you need to
convert it into a color separation. Preparing
your artwork for color separations is relatively
simple if you know the correct procedures. Dif-
ferent programs have different procedures but
basically all their techniques are the same.

The printing technique that produces full color
originals is called four-color printing, since it
uses four colors. Color separations divide an im-
age into these four process colors: magenta
(process red), cyan (process blue), yellow, and
black. Different combinations of these four
process colors make up all the colors in your il-
lustration (i.e., cyan and yellow make green).
Your color printer will separate the colors so that
your end result gives you four separate pages
(one for each color).
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Color separating programs

Aldus FreeHand and Separator and Adobe Sepa-
rator all support Art Importer fonts in their color
separating processes. Since Aldus Separator and
Adobe Separator assume your font is black, you
must apply a color to notify them to separate.
We suggest coloring them 1002 cyan, yellow, and
black so the characters will be sent to all plates.
The Art Importer fonts are able to sort out the
internal colors properly, once they are sent to
the printer. If your characters contain only black,
they take their true color from the color you
assign when you use the character.

Note: Although you can use Art Importer fonts

in Quark Xpress, you cannot separate those fonts.
A future Xpress release should correct this.
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Using The Art Importer with your
KeyMaster fonts

82

If you have a KeyMaster font to which you'd
like to apply The Art Importer’s capabilities, you
can update it.

To use a color KeyMaster font:

If your KeyMaster font had artwork that
was a color PICT2 or Hlustrator file with
custom colors, you must reimport your art-
work into an Art Importer character slot.

"Save” your font in the standard fashion.

Reinstall your PostScript and bitmap fonts.

To update a KeyMaster font:

&

Open your "KeyMaster font” using The
Art Importer’s "Open font” option in the

File menu.

Save your font in the standard "Save as. . .”
fashion.

Reinstall your PostScript and bitmap fonts.
Note: Some font installation programs will
not allow you to open a font while the font
is already open. You may need to remove or

close your bitmap file before you can open
it.
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Font size

The size of the fonts you create with The Art
Importer is limited only by the amount of mem-
ory in your printer. If you seem to be getting an
inordinate number of PostScript errors from Art
Importer fonts, consider using fewer characters
in the font or simplifying the original artwork
and then reimporting it into The Art Importer.

Printing discrepancies

The Art Importer translates a PostScript docu-
ment’s coordinates into a 1000-unit coordinate
system. This works fine for most documents, but
if you have a very large document with some
very long miter joins, you may notice some de-
viations in the way your Art Importer character
prints. If you do notice this, the solution is to go
to your original document and move the points
in question slightly, export EPS, reimport the
EPS into The Art Importer, and try again.

Retaining proportions within your font

If you have two or more pieces of artwork that

have relative proportions that you would like to
retain:

+ In the original drawing program, create a
rectangle (i.e., a tight bounding box) that
will just contain the largest of your draw-

ings.
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+  Define the rectangle as having "no line or
line width.” Each application varies as to
how this option is defined.

+  Place a copy of this rectangle around each
of your drawings before exporting them as
EPS.

The end result is an invisible rectangle
around each piece of artwork. The Art Im-
porter will size the artwork based on the
rectangle and the relative proportions are
maintained.

Non-object oriented PICTs

86

There are many programs that produce the
PICT format. Drawing programs produce ob-
ject oriented PICTs and paint programs pro-
duce bitmap PICTs. The Art Importer can only
read object-oriented PICTs. There are a few ex-
ceptions to this rule.

SuperPaint can produce both object-oriented
and bitmap PICTs. You may use SuperPaint to
create PICTs for import into The Art Importer.
Any drawing that was done in the drawing layer
will show up in the PostScript character because
it is object-oriented. Any drawing that was done
in the painting layer will not show up.
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TROUBLESHOOTING

Here are some common questions asked of our
technical support department:

Why doesn’t my installed font show up in the
font menu of my program?

If you've followed the directions on page 71
and your font doesn't show up in a pro-
gram'’s font menu, check the version of your
program. For example, Aldus PageMaker 3.0
cannot use The Art Importer's NFNT fonts;
you must have version 301 or above. If
you're using versions of Microsoft Word less
than 4.0, see your Microsoft Word manual.

Why do my fonts print in Courier?

Appendix B

If one of the characters in your Art Importer
font has some text in it and the Courier font
prints in place of the font in your artwork,
make sure that you have previously down-
loaded the font in question into your
printer. An alternative to downloading the
font is to insert a single space character in
the desired font (that you used in the Art
Importer character) just before the Art Im-
porter character in your document. This

will cause the desired font to be down-
loaded ahead of The Art Importer font.
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Why does my font change to something com-
pletely unexpected when I move a document
created on my computer to some other com-

puter?

Assuming that you have correctly installed
your font on both computers, the reason this
can happen is that some programs refer to
fonts by number rather than by name. When
you install a new font into a System, the
Font/DA Mover can (if the System already
contains a font with the same number) re-
number the font you're installing without
telling you that it has done this renumber-
ing. Programs that refer to fonts by number
will then think they should use the font that
has the same number as your font (the font
that caused the renumbering of your font)
rather than your (now renumbered) font. If
this seems confusing, you should probably
use programs like Aldus FreeHand or Aldus
PageMaker which refer to their fonts by
name rather than number. Check with the
vendor of your program to make sure it re-
fers to fonts by name in order to avoid this
problem.

What if I don’t have a PostScript printer?

If you are trying to print your Art Importer
font to a bitmapped printer like an
ImageWriter or a LaserWriter [ISC, your
printouts will not look as good as when they
are printed on a PostScript printer. These
printers do not understand PostScript and
can thus use only the bitmaps for printing.
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If you do wish to use these printers, you can
have The Art Importer create bitmap sizes
that are three times the screen sizes for the
ImageWriter LQ, or four times the screen
sizes for the LaserWriter IISC. For example,
if you want to print a 24-point Art Importer
font on an ImageWriter LQ, you must cre-
ate a 72-point bitmap font in addition to the
24-point one (24 X 3 = 72), and if you
wanted the same size (24) to print on a Las-
erWriter 1ISC, you'd have to create a 96-
point bitmap also. On an ImageWriter | or
II, you must have bitmap sizes double those
of the screen fonts (i.e. for a 24-point screen
font, you must have a 48-point size for print-

ing).

Why does my font print jagged looking bitmap-
ped characters instead of the smooth ones I
expect of PostScript?

If your printer does have PostScript and you
are still getting bitmapped results, the prob-
able cause is that you have not installed the
PostScript font file into your System Folder.
Simply drop the PostScript font file into
your System Folder and try again.

Why does my printer give me a PostScript er-
ror when I use my font?

You may have too many fonts already down-
loaded into your printer or your font may be
too large for the printer to handle. The next
page has some suggestions to help solve this
problem.
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What to do if:

You have too many fonts:

If you are already using several download-
able fonts, loading an Art Importer font into
your printer could cause it to exceed its
available memory. If this happens, turn your
printer off and then turn it back on before
attempting to print again. You may have to
simplify your document by reducing the
number of downloadable fonts used. Newer
print driver software supports “Unlimited
downloadable fonts" via a checkbox in the
Page Setup dialog. Programs such as Aldus
PageMaker and Aldus FreeHand 20 can
have unlimited downloadable fonts and
could thus solve this problem.

Your font is too large:

Your font may be too large for the printer to
handle. If your Art Importer font contains
many very complicated pictures, then it is
possible for your printer to run out of mem-
ory when it attempts to print your font. You
may have to simplify your font to reduce its
size. A more permanent solution would be
to get a printer like a LaserWriter II NTX
or a PostScript clone printer which has ex-
pandable memory.
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Why doesn’'t my font show up when I use the
Font/DA Mowver?

You must use Font/DA Mover version 38 or
above with The Art Importer fonts. If you
use Font/DA Mover version 3.6 or below.
YOU WILL NOT SEE YOUR ART IM-
PORTER FONTS. Apple's Font/DA Mover
38 or above is distributed with System 6.0
or above.

Help, I can’t remember which keystroke I put
my art into!

Appendix B

If you forget which keystroke holds a par-
ticular picture in your Art Importer font,
you can refer to The Art Importer's keymap
printout. Keeping a hard copy for reference
purposes such as this, is a good idea.

You can also use the Key Caps desk acces-
sory which appears in the Apple menu. Se-
lect the Key Caps desk accessory, select the
name of your font from the Key Caps menu
that will appear on your menu bar, type dif-
ferent keystroke combinations until you find
your artwork's specific key.

However, sometimes it is difficult to make
out the Key Caps image on screen, in
which case having an Art Importer keymap
printout would be more effective.
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The Art Importer runs out of memory some-
times while I am importing artwork. What am I

doing wrong?

You aren't doing anything wrong. If you im-
port several large pieces of artwork in suc-
cession, it is possible for The Art Importer
to run out of memory during the import of
another large piece of artwork. You can
avoid this problem by using the "Save” com-
mand from the File menu after you import a
large piece of art. This causes everything in
memory to be written out to your disk.
Once written to disk, the information can
be discarded from memory. Now you can
start importing again.

Sometimes The Art Importer won't allow me to
save my font, telling me that I don’t have

enough memory. Is there anything I can do?

Yes. You can delete (or clear) one of your
characters and try to "Save” again. If you
still receive an "Out of memory” alert, keep
deleting and saving characters until The Art
Importer saves your font. Then you can re-
import the deleted artwork into your font.
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The Altsys F

FONTOGRAPHER

Fontographer is a specialized graphics editor
designed to simplify the creation of high-quality
PostScript typefaces and logos. With Fontogra-
pher, you can add new characters to existing
fonts or create your own fonts, logos, or custom
art and have them all available at the touch of a
keystroke. You can even use Fontographer to
convert scanned line art to create your own pic-
ture font.

Whether you are a novice or an experienced
graphic designer, Fontographer provides the
means to assign your typographic images to any
key or combination of keys, and the added abil-
ity to instantly repeat and resize these images in
any application.

Using Fontographer's drawing tools, you can cre-
ate a professional-quality PostScript character in
minutes and print that character on a Laser-
Writer or any PostScript compatible printer. With
Fontographer and your Macintosh, you can cre-
ate type designs that rival those produced by
professional typographers.

Fontographer differs from The Art Importer in
its ability to support drawing, autotracing, and
setting kerning pairs. It is designed for making
commercial typefaces as opposed to The Art
Importer’s focus on creating simple fonts quickly.
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FONTASTIC PLUS

94

Fontastic Plus is Altsys’ specialized bitmap font
editor. It was designed to create new fonts and
typefaces and customize existing character sets
with distinctive characters, logos, and graphics.

Using MacPaint-like tools, you can easily create
bitmap logos, foreign characters, clip art, and
custom fonts, Images can be cut and pasted into
a font from other applications (i.e., MacPaint).
Special effects like scaling (up to 127 points) can
be performed, along with rotation, styling, and
editing to provide a quick and easy way to de-
sign attractive fonts and graphics. An integrated
font mover makes installing your fonts as simple
as "Cut” and "Paste.”

Fontastic Plus includes standard Altsys features
such as kerning pairs and fractional character
widths and allows for high-quality printing on
QuickDraw printers.
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FAMLY BUILDER

Family Builder combines a group of already de-
signed fonts into a "Font Family." This special-
ized program is Altsys' answer for those font de-
velopers who wish to combine their fonts into a
family of related styles.

Family Builder can be used to combine either
bitmap or PostScript fonts into families sharing
one name in the Font menu. For example: a
family containing GoudyBold, Goudyltalic, and
Goudy Boldltalic would appear as Goudy in the

font menu.

Aldus FreeHand

Aldus FreeHand, designed and written by Altsys
Corporation, is a powerful, precise, and easy-to-
use PostScript illustration and design tool for the
Apple Macintosh. Like all Altsys products, Aldus
FreeHand meets the demands of commercial
artists and designers, and yet is simple enough
for the average user.
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